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1.0

LEARNING OBJECTIVES

After going through this unit, you will be able to:
● Work with MS Excel
● Define Row, Column and Cell in MS Excel
● Use cell addressing
● Insert and delete Rows and Columns in Excel
● Use formulas in a worksheet
1.1

INTRODUCTION

Microsoft Excel is a spreadsheet application developed by Microsoft for Microsoft
Windows and Mac operating system. Microsoft Excel has a grid of cells arranged in
numbered rows and letter-named columns to organize data manipulations like
arithmetic operations. It has a collection of functions to answer statistical, engineering
and financial needs. In addition, it can display data as line graphs, histograms and
charts, and with a very limited three-dimensional graphical display. In this unit we will
be discussing some of the basic and introductory concepts of Microsoft Excel.
Throughout this unit we will be using the Microsoft Office 2010 suite for all the
diagrammatic illustrations, examples, and explanations.
1.2

STARTING MS EXCEL

To start using the MS Excel application, we need to have the MS Office suite installed
in our machine. To start MS Excel we do the following 1

● We first click on the Windows Start button.
● Then from the Programs menu we select the Microsoft Office suite.
● This opens the items included in the suite where from we select Microsoft
Excel

1.3

ROW, COLUMN AND CELL

Rows in an Excel sheet are the horizontal lines numbered 1, 2, 3, etc., and Columns
are the vertical lines denoted by letters A, B, C, D etc.

The Rows and Columns in an Excel Worksheet are in the form of overlapping
horizontal and vertical lines respectively that run through an Excel worksheet. The
point of intersection of a Row and a Column is known as a Cell, and thus all cells in
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an Excel worksheet are formed in this manner. We enter mathematical data into these
cells and perform some mathematical operations.
1.4

CREATING, SAVING AND CLOSING A WORKBOOK

A Microsoft Excel workbook is a file which contains one or more worksheets that can
be used to organize various kinds of related data. To create a new workbook, one can
open a blank workbook. A new workbook can be based on an existing workbook, the
default workbook template, or any other template.
Creating a workbook To create a new, blank workbook we do the following:
● We click the File tab.
● Then we click New.
● We then double-click Blank Workbook or select a workbook type and click
Create.
To quickly create a new, blank workbook, we can also press CTRL+N.
To base a new workbook on an existing workbook we do the following:
● We click the File tab.
● Then click New.
● Under Templates, we click New from Existing.
● In the New from Existing Workbook dialog box, we browse to the drive, folder,
or Internet location that contains the workbook which we want to open.
● Then we click the workbook, and then click Create New.
Saving a Workbook There are several options in MS Excel that allows us to save a workbook depending
on our needs and preferences that define how we plan to use those workbooks in the
future.
To save a document for the first time we do the following:
● On the Quick Access Toolbar, we click Save, or press CTRL+S.
● We type a name for the document, and then click Save.
To save an existing document as a new document, and to prevent overwriting the
original document, we do the following:
●
●
●
●

Firstly we open the document that we want to save as a new file.
Then we click the File tab.
Then we click Save As which opens the dialogue box
We type a name for the document, and then click Save, which saves the
document in a default location. In order to save the document in a different
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location, we have to click another folder in the Save in list in the Save As dialog
box

Closing a workbook Closing an Excel workbook without exiting MS Excel results in closing the current
workbook, but not the entire MS Excel application.
To close an Excel workbook we do the following:
1. Firstly we perform any one of the following.
● We select the File menu and click Close
● We click the Close window button that is located below the Close button to
quit Excel.
2. If the workbook has been saved previously, it gets closed. Else we are asked to save
the current workbook.
1.5

WORKING WITH CELLS

Working with cells in a MS Excel workbook involves inserting data in the cells,
inserting and deleting cells and formatting cells. Among these operations, inserting
data is as simple as typing. Formatting a cell involves several operations like choosing
and applying a cell style, changing the Cell size, etc.
To insert cells we do the following:
● From the Cells group under the Home tabs, we click Insert and select Insert
Cells from the drop-down menu.
● This opens the dialog box below.
● We then select any option of the four options and click OK.
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To delete cells we do the following:
● From the Cells group under the Home tabs, we click Delete and select Delete
Cells from the drop-down menu.
● This opens the dialog box below.
● We then select any option of the four options and click OK.

To apply a style to a cell we do the following:
● From the Styles group under the Home tabs we select Cell Styles.
● From the drop-down list of all the available styles we select the style we want.
To change the size of a Cell we do the following:
● From the Cells group under the Home tabs we click Format which opens the
drop-down menu of Figure below.
● We can change the Cell Size by adjusting the Row Height and Column Width
values.
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CHECK YOUR PROGRESS
Q 1: State whether True or False:
a) We enter mathematical data into Excel cells and perform mathematical operations.
b) By default, a new workbook contains five worksheets.
c) Closing an Excel workbook without exiting MS Excel results in closing the current
workbook, but not the entire MS Excel application.
d) Formatting a cell involves choosing and applying a cell style.
e) We cannot apply a style to an individual cell in Excel.
1.6

MERGING CELLS

Merging cells in MS Excel is the process of combining a group of cells into one single
cell. This process involves selecting more than one cell and creating a single cell by
combining all of the selected cells by using some cell manipulation features in MS
Excel.
To merge cells together we do the following:
1. We first select the cells to be merged.
2. From the Alignment group under the Home tabs as shown in Figure we click
Merge and Center which shows the drop-down menu of Figure 9.8 below.
3. The drop-down menu of Figure has four options ● Merge and Center merges the selected cells and center-aligns the contents.
● Merge Across merges the selected cells across.
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● Merge Cells simply merges the cells keeping intact the previous alignment of
the content.
● Unmerge the merged cells into the original layout.

Alignment Group

The Merge and Center drop-down menu
Cells can also be merged from the Format Cells dialog box by following these
steps.
● We first select the cells to be merged together.
● Then we follow any one of the following steps to open the Format
Cells dialog box of Figure below ● We may press CTRL+1.
● We right-click on the selected cells and select Format Cells from the drop-down
menu.
● From the Format option in the Cells group under the Home tabs, we select Format
Cells.
From the Format Cells dialog box, we select the checkbox for Merge cells under the
Alignment tabs and press OK.
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1.7

INSERTING AND DELETING ROWS AND COLUMNS

Sometimes in an Excel worksheet we may need to insert some additional rows or
columns or may need to delete them. We can insert rows above a selected row in an
Excel worksheet, and columns to the left of a selected column. Likewise we can also
delete rows and columns.
To insert Rows/Columns we do the following:
● We first select the row above which we are to insert a new row, or the column
to the left of which we are to insert a new column.
● Then we click the Insert option from the Cells group under the Home
Tabs as shown in Figure below, which displays the Insert dropdown menu of Figure .
● Then we select the option we want according to whether to insert a row or
column.

To delete Rows/Columns we do the following:
● First we select the Row(s)/Column(s) to be deleted.
● Then we click the Delete option from the Cells group under the Home tabs as
shown in Figure below, which displays the Delete dropdown menu of Figure
below.
● Then we select the option we want to delete either a row or a column.
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1.8

WORKING WITH FORMULA AND CHARTS

●

Formulas - Formulas in MS Excel are equations that can perform calculations,
return information, manipulate the contents of other cells, test conditions, etc. The
formula always goes in the cell where we want the formula answer to appear.

●

Cell Reference: A cell's location in the spreadsheet is referred to as its cell
reference which is a combination of the column letter and row number - such as
A1, B3, or Z345. When writing cell references the column letter always comes
first. Therefore, to find a cell reference, we simply look at the column headings to
find which column the cell is in, and across to find which row it is in.

●

Creating Formulas: When creating formulas in Microsoft Excel, we always start
by typing the equal sign. The equal sign informs Excel that what follows is part of
a formula, and not just a name or a number. We type it in the cell where we want
the answer to appear by combining the cell references of our data with the correct
mathematical operator.

The mathematical operators used in Excel formulas are similar to the ones used in
mathematics. If more than one operator is used in a formula, there is a specific order
that Excel will follow to perform these mathematical operations. This order of
operations can be changed by adding brackets to the equation.
How to write formulas:
Writing formulas in a proper way gives us the correct result as the answer. When doing
so it is best if we first enter all of our data into the spreadsheet before we begin creating
formulas.
Example to ADD two numbers: Suppose we are to add two numbers located in two
different cells
A1 and A2. We choose the cell A5 as the result cell where the formula result has to be
displayed. We follow these steps:
1. We enter the two numbers to be added in cells A1 and A2.
2. Then select cell A5 and write any one of the following = SUM (A1,A2) =
(A1+A2)
3. Then as we press ENTER, the result of addition of the numbers in cells A1 and
A2 is displayed in cell A5.
Note: In case we need to add several numbers located in cells A1 through to A10, we
simply need to put a semicolon (:) between the first and the last cell-references as
=SUM (A1:A10). However this method of including a range of numbers to add using
a semicolon works only when we use a function name. Here, SUM is a function name.
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There are several formulas in Excel which can be used to perform operations that
include numerical, statistical, financial, logical, trigonometric, engineering etc. Figure
9.13 shows a list of formulas that can be accessed from the Function Library group
under the Formula tabs. Clicking on any function type will list drop-down menus
showing a collection of the formulas of the chosen type.

Charts - Charts are used in Excel to provide graphical representation of numerical data
in a way that corresponds to the relationship among the numerical values. When
creating a chart or changing the type of an existing chart in Microsoft Excel, we can
select one of the following chart types.
Column charts: Data that is arranged in columns or rows on a worksheet can be
plotted in a column chart. Column charts are useful for showing data changes over a
period of time or for illustrating comparisons among items. In column charts,
categories are typically organized along the horizontal axis and values along the
vertical axis.

Line charts: Data that is arranged in columns or rows on a worksheet can be plotted
in a line chart. Line charts can display continuous data over time, set against a common
scale, and are therefore ideal for showing trends in data at equal intervals. In a line
chart, category data is distributed evenly along the horizontal axis, and all value data
is distributed evenly along the vertical axis.
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Pie charts: Data that is arranged in one column or row only on a worksheet can be
plotted in a pie chart. Pie charts show the size of items in one data series, proportional
to the sum of the items. The data points in a pie chart are displayed as a percentage of
the whole pie.
We must consider using a pie chart when:
● There is only one data series to plot.
● None of the values to be plotted are negative.
● Almost none of the values that we want to plot are zero values.
● There are not more than seven categories to be plotted.
● The categories represent parts of the whole pie

Apart from the above mentioned chart types there are other chart types as well like
Area chart, Scatter charts, Stock charts, Surface charts etc which can be used for other
different purposes.
CHECK YOUR PROGRESS
Q 2: Fill in the blanks:
(a) ................... cells in Excel involves selecting more than one cell and creating a
single cell by combining all of the selected cells.
(b) ................... always go in the cell where we want the formula answer to appear.
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(c) A cell's location in the spreadsheet is referred to as it’s ................... which is a
combination of the column ............... and row................
(d) The ................... used in Excel formulas are similar to the ones used in
mathematics.
(e) The ................... sign in an Excel formula informs Excel that what follows is part
of a ..................., and not just a name or a number.
(f) ................... charts are useful for showing data changes over a period of time or
for illustrating comparisons among items.
(g) In column charts,................... are typically organized along the horizontal axis and
................... along the vertical axis.
(h) ................... charts can display continuous data over time, set against a common
scale, and are therefore ideal for showing trends in data at ................... intervals.
(i) ................... charts show the size of items in one data series.
1.9

LET US SUM UP

● Microsoft Excel is a spreadsheet application program.
● A Microsoft Excel workbook is a file that contains one or more worksheets that
can be used to organize various kinds of related data.
● Rows in an Excel sheet are the horizontal lines numbered 1, 2, 3, etc., and Columns
are the vertical lines denoted by letters A, B, C, D etc.
● The point of intersection of a Row and a Column is known as a Cell.
● Merging cells in MS Excel is the process of combining a group of cells into one
single cell.
● We can insert rows above a selected row in an Excel worksheet, and insert
columns to the left of a selected column.
● Formulas in MS Excel are equations that can perform calculations.
● When creating formulas in Microsoft Excel, we always start by typing the equal
sign.
● Charts are used in Excel to provide graphical representation of numerical data.
1.10

KEYWORDS

● Data: Facts and statistics collected together for reference or analysis.
● Cell : A cell is the intersection between a row and a column on a spreadsheet that
starts with cell A1
● Charts: A chart is a tool you can use in Excel to communicate data graphically.
Charts allow your audience to see the meaning behind the numbers, and they make
showing comparisons and trends much easier.
● Workbook: A workbook is a file that contains one or more worksheets to help
you organize data.
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1.11

ANSWERS TO CHECK YOUR PROGRESS

Ans to Q No 1: (a) True b) False c) True d) True e) False
Ans to Q No 2: (a) Merging, (b) Formulas, (c) cell reference, letter, number. (d)
mathematical operators, (e) equal, formula, (f) Column (g) categories, values, (h) Line,
equal, (i) Pie
1.12

FURTHER READING

● Weixel Suzanne, Wempen Faith, Skintik C, “Learning Microsoft Office 2010”,
Standard Student Edition, Pearson
● Davis G.H. “Beginning Microsoft Office 2010”, Apress publisher.
● Rutkosky S., “Microsoft Office 2007”, BPB Publication.
1.13

MODEL QUESTIONS

Q 01: What is Microsoft Excel? Describe its use?
Q 02: Explain the process of starting MS Excel, creating, saving and closing a
workbook.
Q 03: How do we insert and delete cells in Excel?
Q 04: Explain how rows and columns can be inserted and deleted in an Excel
worksheet.
Q 05: How can we merge cells in MS Excel?
Q 06: What are Formulas in MS Excel? Illustrate their use using an example.
Q 07: What are charts in MS Excel? Mention any two chart types along with their
use.
Q 08: What are Area charts in MS Excel? Give an example
Q 09: Illustrate the use of Line charts using some sample data.
Q 10: Create a pie chart using the following data. Ice-cream flavors Price in Rupees
Candy 35 Strawberry 25 Apple 55 Orange 45 Mango 50
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2.0

LEARNING OBJECTIVES

After reading this chapter, the students should be able to know:
● Understand the Importance of Electronic Spreadsheet in Business
● Discuss the Categorization of Electronic Spreadsheet as per the Use of
Corporate World
● Elaborate the application of Electronic Spreadsheet in performing various
Management Function
2.1

INTRODUCTION

A spreadsheet is a computer application for organization, analysis and storage of data
in tabular form. Spreadsheets were developed as computerized analogs of paper
accounting worksheets. The program operates on data entered in cells of a table. A
spreadsheet may also refer to one such electronic document. Spreadsheets are an
essential business and accounting tool. They can vary in complexity and can be used
for various reasons, but their primary purpose is to organize and categorize data into a
logical format. Once this data is entered into the spreadsheet, you can use it to help
organize and grow your business. The most common spreadsheet program that
accountants use is Microsoft Excel. This product was initially developed in the 1990s
in the Office Suite program package and has since become the industry standard.
Spreadsheets allow accountants to do much more than organize data. They can
14

manipulate it in order to test the impact that alternative strategies and performance
results would have on the company’s bottom line. They can also use the software to
make predictions about future performance, development, and even market trends.
2.2

IMPORTANCE OF ELECTRONIC SPREADSHEET FOR BUSINESS

Spreadsheets are used in varied ways within business contexts. In general, spreadsheets
store data sets, but they also provide a range of utilities to manage and process the data
sets. This makes them particularly useful to businesses. Through preset and userdefined formulas, spreadsheets can perform mathematical, statistical, financial and
organizational transformations on sets of data. Spreadsheets help to present data in
organized ways and to inform future planning decisions. Businesses use spreadsheets
in ways that are suited to their own services, but these uses tend to fall into a few
general categories.
(i)
Storing Data
The primary purpose of a spreadsheet is to store data in a structured way. Data values
are entered into cells in a worksheet. These data values can be formatted using various
categories of data types, including numerical and textual types. The cells in a
worksheet can refer to other cells, using the location of a cell within the rows and
columns in the sheet. Individual parts of a worksheet can be contained within tables,
with a single worksheet potentially holding a range of information sets. Spreadsheet
programs such as Excel provide templates for common business tasks, such as
expenses recording.
(ii)
Analyzing Data
Once a spreadsheet has some data values in it, one can perform various analytical tasks
on this data. This includes mathematical functions, such as adding or counting values.
By entering a formula or choosing from one of many preset functions, one can analyze
his data sets. This allows business users to sort data, filter it and process it. For financial
data, users can calculate profits and losses. In a general sense, spreadsheet formulas
and functions allow user to carry out performance measurements for many aspects of
his business.
(iii) Presentation
Spreadsheet applications such as Excel include tools for data visualization. Users can
take an existing data set within a spreadsheet and present it within a chart, with various
types of graph and chart options to choose from. The resulting charts let business
managers gain insight into the data by presenting it in graphical ways. These charts
can also be used in corporate contexts, such as within presentations. Users can
manually control all aspects of a chart display, including chart type, labeling and
colors. Users can also print spreadsheet tables and charts for use within reports and
other publications. These charts can be used within management teams to gain an
insight into the data, as well as to communicate this data as part of presentation
activities in corporate contexts.
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(iv)
Future Planning
Spreadsheets facilitate future planning in two ways. First, being able to analyze and
visualize data gives users an insight into how well his business is currently performing,
highlighting areas for growth or reconsideration. Second, users can use a spreadsheet
to calculate the potential effects of changes to his business model. For example, if a
user uses existing information together with a potential change, such as a sales
fluctuation in a retail context, he can determine the impact of this change. Spreadsheets
also use conditional formulas, in which users can carry out conditional tests on data
values, filtering or manipulating the values as a result of these tests.
2.3

CATEGORIZATION OF ELECTRONIC SPREADSHEET AS PER
THE BUSINESS REQUIREMENT

In the corporate world, spreadsheet use is divided in two categories: modeling and
operational. Spreadsheets created for modeling purposes act as complex calculators
and address a particular activity, such as mergers and acquisitions. On the other hand,
spreadsheets created for operational use support transactional processes, thus
becoming a core business program containing static and changing data, as well as all
the calculations applied to the data. One common application of operational
spreadsheets is maintaining business lists, such as inventories and confidential
customer information. Operational spreadsheets have more users over a longer period
of time, who have less knowledge of the spreadsheet's underlying structure. Because
of this, operational spreadsheets are a greater regulatory concern during compliance
reviews, and internal auditors should pay close attention to their use and the accuracy
of their data.
Difference between Modelling Spreadsheet and Operational Spreadsheet
Modelling Spreadsheet
Users

Operational Spreadsheet

Single. Built and used by the Multiple. Built by an IT developer for
same individual most of the corporate wide use
time.

Duration of Short term. Spreadsheet models,
often complex, are built for days
Use
or weeks only to be redundant
after the relevant business
decision is made.

Long term. Spreadsheet models, both
simple and complex, become part of
the
business' information flow and persist
for months or years

High. Substantial structural
revisions are likely to occur
from one day to the next as
major elements are added or
replaced.

Low to medium. All key structural
elements are likely to be in place.
Further evolution of the business
process requires spreadsheet
maintenance, with rare structural

Structural
&
Functional
Volatility
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overhauls
Data
Volatility

Medium. Data are related High. As the application matures,
primarily to the exploration of transactional data become key
alternative scenarios
spreadsheet variables

Use
Intensity

Intensive. Use is likely to be
intensive for a short period of
time, and the knowledge of the
spreadsheet's structure among
its users is retained throughout
its life

2.4

Sporadic. Use depends on the nature
of the business process being
supported. For example, many
spreadsheets in financial reports are
used at the end of the month. This
means employees may forget how to
use key spreadsheet functions.

USE OF ELECTRONIC SPREADSHEET IN ACCOUNTING

The electronic spreadsheet has been in use in all the three branches of accounting i.e.,
financial accounting, cost accounting and management accounting. Microsoft Office
Excel was designed to support accounting functions such as budgeting, preparing
financial statements and creating balance sheets. It comes with basic spreadsheet
functionality and many functions for performing complex mathematical calculations.
It also supports many add-ons for activities such as modeling and financial forecasting,
and seamlessly integrates with external data to allow users to import and export
banking information and financial data to and from other accounting software
platforms.
Use of Electronic Spreadsheet in Financial Accounting: All the business houses are
using spreadsheets in bookkeeping as well as for preparing financial statements. Some
of the important examples of application of electronic spreadsheet in financial
accounting are as follows:
(i)

Accounts payable is money owed by a business to its suppliers shown as a
liability on a company‘s balance sheet.
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(ii)

Accounts receivable is a legally enforceable claim for payment held by a
business for goods supplied and/or services rendered that customers/clients
have ordered but not paid for. These are generally in the form of invoices raised
by a business and delivered to the customer for payment within a time period.

(iii)

Cash book is the record of cash transactions done in a company on a day to
day or regular basis. Cash book is just like a ledger account.

(iv)

Invoice is a document issued by a seller to the buyer for a transaction. It
consists of details of services or goods supplied along with rates of services
provided or per unit price of goods. An Invoice is issued to the receiver of goods
or services for payment.
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(v)

A Petty Cash Book is a document in which all petty or small daily routine
payments made from petty cash funds are systematically recorded. In other
words, Petty Cash Book is a type of Cash Book which is generally maintained
in large businesses to reduce the burden of the 'Main Cash Book‘.
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(vi)

A purchase order (PO) is a commercial document and first official offer
issued by a buyer to a seller, indicating types, quantities, and agreed prices for
products or services. It is a buyer-generated document which states the
requirements and serves as a legal document authoring a purchase transaction.

(vii)

A bill of lading is a document detailing how goods are being shipped from a
seller to a recipient. It includes details about the items being shipped, the
quantity of items included in the shipment, and the destination address.

(viii) Creating a cash flow forecast can be helpful for managing business ‘finances.
It enables users to estimate how much money his business will make and spend
at any given point, and will allow users to take the appropriate steps to ensure
that cash outflow is not more than inflow.
(ix)

Asset Accounting: Assets are the properties of a business which are acquired
for the purpose of earning income. Assets can be classified into Fixed Assets
and Current Assets. Fixed Assets are long term and provide productive
capability of the business. It includes both tangible and intangible assets.
Buildings, Land, Plant, Machinery, Furniture, and Goodwill etc are examples
of Fixed Assets. Depreciation should be charged on fixed assets so as to recoup
the amount spent on fixed assets. Depreciation is charged on fixed assets as per
the policy of the organization. Normally there are two methods for charging
depreciation; they are Straight Line Method and Written down Value method.

SLN FUNCTION IN SPREADSHEET
In excel there is a simple function called SLN () to calculate depreciation under
Straight Line Method. The syntax of SLN Function is = SLN (Cost, Salvage, Life)
Where cost = Acquisition cost of asset, Salvage = Salvage value at the end of asset‘s
life, Life = Useful life of the asset
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Example: An asset purchased for Rs.9,000 and its installation cost is Rs.1,000. The
useful life of the asset is 10 years, at the end of which it will bring salvage value of
Rs.2,000. These details can be applied in SLN Function to calculate Straight Line
Depreciation as follows:- =SLN(10000,2000,10) Then we will get the result as
Rs.800/Illustration 01
Below is given the details of various assets in a concern. Calculate the Straight Line
Depreciation by using SLN () function in excel.
Name
Asset

of Cost
of Installation Transportation Pre
Salvage Life in
Purchases Charges
Charges
Operating Value
Years
Expenses

Machinery

20,000

2,000

4,600

1,200

12,000

10

Furniture

40,000

3,500

1,500

500

3,000

8

Land

4,50,000

0

0

5,000

15,000

12

Building

3,00,000

0

0

8,000

20,000
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Solution:
The given details are arranged in a worksheet as follows. We have added only two
columns to the given details. One is to calculate the Total Acquisition Cost of Assets
and other is to calculate the depreciation.
In the cell H2 enter the formula = Sum (B2:E2)
In the cell I2 enter the formula = SLN (H2,F2,G2)
And copy down these formulas to the remaining rows then the result will be as follows:
A

B

C

D

E

F

G

H

I

Name of Cost of Installation Transporta Pre
Salvage Life in Acquisitio Straight
the Asset Purchase Charges
tion
Operating Value
Years n Cost
Line
Charges
Expense
Depreciati
on
Machinery 20000

2000

4600

1200

12000

10

27,800

1,580.00

Furniture

40000

3500

1500

500

3000

8

45500

5,312.50

Land

450000

0

0

60000

15000

15

510000

33,000

Building

300000

0

0

8000

20000

20

308000

14,400
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Written Down Value (WDV) Method
The Written down Value method uses the current book value as the base for calculating
depreciation for the next period. It is also called Declining Balance method or
Diminishing Balance method. In excel the DB() function is used to calculate
depreciation under Written Down Value method. The syntax of DB() function is as
follows:
DB ( cost, salvage, life, period, [number_months] )
Where as Cost : The original cost of the asset.
Salvage : The salvage value after the asset has been fully depreciated.
Life : The useful life of the asset or the number of periods that user will be depreciating
the asset.
Period : The period that user wishes to calculate the depreciation
Number_months: Optional. It is the number of months in the first year of depreciation.
If this parameter is omitted, the DB function will assume that there are 12 months in
the first year.
Calculation of Number of Months and Period
In the above three examples, all the parameters are directly entered in the formula. But
we can automate the calculation of Number of months in the beginning year and Period
for which depreciation is calculated by using some additional formulas. Consider the
following table. In this only the Asset Installation date (in B1) and Current Year ending
date (in B2) are given. Let us examine how No. of months in the beginning year and
Period elapsed is calculated.
No. of months in the beginning year means the no. of months from the installation date
to the closing date of the beginning year. So first we have to calculate the ending date
of the first year. If the accounting year ends on 31st Dec each year, it needs a simple
formula to calculate the ending date of the first year. In the Cell B3, we can give the
following formula in such a case
=Date (Year(B1),12,31)
In the given example, the above formula brings the result as 31/12/2008 But if the
accounting year overlaps between two calendar years(E.g.- From 1st April to 31st
March) , it requires some more large formula to calculate the exact ending date of first
year as follows:=IF(AND(MONTH(B1)>0,MONTH(B1)<4),DATE(YEAR(B1),3,31),DATE(YEAR
(B1)+1,3,31))
Or
=IF(MONTH(B1)>3,
DATE(YEAR(B1)+1,3,31),DATE(YEAR(B1),3,31))
After finding the year end date of the first year, the next step is to find out the number
of months between installation Date and End date of First year. When a date is
subtracted from another, excel gives the result as the number of days between these
two dates.
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E.g.: The formula =‖30/06/2015‖ – 01/01/2015‖ will give the result as 180. That means
there are 180 days between these two dates.
In the given example, the year ending date of beginning year is calculated in cell B3
and installation date is given in cell B1. Let us use the formula =B3-B1 to calculate the
difference between these two days. This will give a result of 292 days. Since we require
a number of months instead of days, we can divide the answer by 30 and the formula
can be changed as follows. =(B3-B1)/30. This will give a result of 9.7333 months.
Again in order to avoid the fractions, we can enclose the above formula in a Round
function and the final formula will be as follows:- =Round((B3-B1)/30,0)
Now let us look at how to calculate the period for which depreciation is calculated, i.e.
the number of years elapsed from the date of installation. It can be simply calculated
as subtracting the year of installation from the current year. E.g. If the asset is
purchased on 01/02/2008 and current year end date is 31/12/2015 the simple formula
=Year(31/12/2015‖) – Year(01/02/2008‖) will give the result as 7 years i.e.; 2015 –
2008.
But as we stated earlier, if the accounting year overlaps between two calendar years,
we need some more large formulas. In the example given, the installation date is given
in B1 and Current year ending date is given in B2. Since the accounting year ends on
31st march, we have to give the following formula in the cell B5 to calculate the
number of years elapsed from the date of installation =IF(MONTH(B1)>3,YEAR(B2)YEAR(B1),YEAR(B2)-YEAR(B1)+1)

Loan Repayment Schedule
Loan is a sum borrowed for a specified period at specified rate of interest. The loan is
repaid through a number of periodic installments (normally in monthly installments)
along with interest over the loan repayment period. Computation of repayment
installments is a tedious task. But excels built in PMT function can be used to compute
monthly installments of repayments of loan. This function is already discussed in the
previous chapter 'Spreadsheet’.
Syntax
S=PMT( rate, nper, pv, [fv], [type] )
Where as
rate = interest rate per period for the loan
Nper = number of payments for the loan. The unit must be the same as of interest rate
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Pv = Present Value ie; the loan amount
Fv = Future Value, the value of loan at the end, which is taken as zero
Type = Whether the payment is made at the beginning (Value-0) or at the end
(Value-1)
A bank gave a Housing Loan of Rs.5,00,000 to a customer on 1st April 2005. The loan
carries interest @ 10% p.a and the loan is to be repaid over 10 years. Here the monthly
installments are calculated by the following formula assuming that the installments are
paid at the end of each month. =PMT (10%/12,10*12,500000,0,1) = -Rs.6553. Here
the interest rate is divided by 12 to convert to the monthly rate and the year is multiplied
by 12 to get the number of monthly payments. The monthly answer is shown as a minus
figure since it is an outflow.
2.5

USE OF ELECTRONIC SPREADSHEET IN HRM

In Human resource management also electronic spreadsheets are widely used. One of
the major aspects is managing payroll which is described below.
Payroll Accounting
Every employee is paid salary at the end of a period as per the agreements made
between the employer and employee and in accordance with the policy in force from
time to time in an organization. The computation of salary is based on the Rate of Basic
Pay, No. of days worked and Rate of applicable allowances and deductions.
A Payroll Accounting should have the following features
 Maintain employee related data such as Employee No, Name of employee, Basic
Pay, Applicable allowances, deductions etc.
 Periodic calculation of the payments based on Basic Pay, No of days worked,
Applicable allowances, deductions etc.
 Preparation of salary statements and individual salary slips.
 Generation of advice to banks consisting of net salary to be transferred to
individual accounts of employees and other statutory payments such as Provident
Fund, Tax etc.
Payroll Component
Following are the essential components for the preparation of a Payroll.
1) Current Payroll Period (The period for which the payroll is prepared. Eg. Jan
2015)
2) Earnings:● Basic Pay: It is the pay in the pay scale plus Grade Pay, but doesn‘t include
special pay.
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● Grade Pay (GP): It is the pay to be added to Basic Pay according to the
designation of the employee and applicable pay band or scale of pay.
● Dearness Pay (DP): It is the portion of Dearness Allowance which has been
declared and deemed to have been merged with Basic Pay.
● Dearness Allowance (DA): It is the compensation for reduction in the
purchasing power of money due to price rise. It is granted by the Govt.
periodically as a percentage of Basic Pay + Dearness Pay.
● House Rent Allowance (HRA): It is an amount paid to facilitate employees in
acquiring on lease of residential accommodation.
● Transport Allowance (TA) : Transport allowance granted to employee for the
purpose of travelling between place of duty and residence
● Any other Earnings: Such as Education Allowance, Medical Allowance,
Washing Allowance etc.
3) Deductions:● Professional Tax (PT): It is a statutory deduction according to the legislature
of State Governments.
● Provident Fund (PF): It is a statutory deduction as a part of social security. It
is deducted as a certain percentage of Basic Pay + Dearness Pay.
● Tax Deductions at Source (TDS): It is a statutory deduction. It is the monthly
installment of total Income Tax payable during the year.
● Recovery of Loan Installment (LOAN): Deduction towards loan provided by
the employer to the employee.
● Any other Deductions: Any other deductions made towards Advance against
Salary‘, Food Grains Advance‘, Festival Advance’etc.
2.6

USE OF ELECTRONIC
MANAGEMENT

SPREADSHEET

IN

FINANCIAL

In financial management three crucial decisions are taken (i) Investing Decision (ii)
Financing Decision and (iii) Dividend Decision. The application of electronic
spreadsheets is huge in all sorts of financial decisions. Some of the important
calculations are described as below
Net Present Value
The difference between the present value of the future cash flows from an investment
and the amount of investment. Present value of the expected cash flows is computed
by discounting them at the required rate of return. For example, an investment of
$1,000 today at 10 percent will yield $1,100 at the end of the year; therefore, the
present value of $1,100 at the desired rate of return (10 percent) is $1,000. The amount
of investment ($1,000 in this example) is deducted from this figure to arrive at net
present value which here is zero ($1,000- $1,000). A zero net present value means the
project repays original investment plus the required rate of return
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A positive net present value means a better return, and a negative net present value
means a worse return, than the return from zero net present value. It is one of the two
discounted cash flow techniques (the other is internal rate of return) used in
comparative appraisal of investment proposals where the flow of income varies over
time.
Syntax
NPV(rate,value1,[value2],...)
The NPV function syntax has the following arguments:
Rate Required. The rate of discount over the length of one period.
Value1, value2, ... Value1 is required, subsequent values are optional. 1 to
254 arguments representing the payments and income.
(i)
(ii)

(iii)

(iv)

Value1, value2, ... must be equally spaced in time and occur at the end of
each period.
NPV uses the order of value1, value2, ... to interpret the order of cash flows.
It should be made sure that payment and income values are in the correct
sequence.
Arguments that are empty cells, logical values, or text representations of
numbers, error values, or text that cannot be translated into numbers are
ignored.
If an argument is an array or reference, only numbers in that array or
reference are counted. Empty cells, logical values, text, or error values in
the array or reference are ignored.

The NPV investment begins one period before the date of the value1 cash flow and
ends with the last cash flow in the list. The NPV calculation is based on future cash
flows. If first cash flow occurs at the beginning of the first period, the first value must
be added to the NPV result, not included in the value arguments. For more information,
see the examples below, If n is the number of cash flows in the list of values, the
formula for NPV is:

NPV is similar to the PV function (present value). The primary difference between PV
and NPV is that PV allows cash flows to begin either at the end or at the beginning of
the period. Unlike the variable NPV cash flow values, PV cash flows must be constant
throughout the investment. For information about annuities and financial functions,
see PV.
NPV is also related to the IRR function (internal rate of return). IRR is the rate for
which NPV equals zero: NPV (IRR(...), ...) = 0
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● Internal Rate of Return
The internal rate of return (IRR) is the core component of capital budgeting and
corporate finance. Businesses use it to determine which discount rate makes the present
value of future after-tax cash flows equal the initial cost of the capital investment. Or,
to put it more simply: What discount rate would cause the net present value (NPV) of
a project to be $0? We expect that projects to grow our business will give us some
return over time, so what is the lowest level of return we can tolerate? The lowest level
is always the cost of capital to fund the project.
If a project is expected to have an IRR greater than the rate used to discount the cash
flows, then the project adds value, while if the IRR is less than the discount rate, it
destroys value. This decision process to accept or reject a project is known as the IRR
Rule.
One advantage of using IRR, which is expressed as a percentage, is that it normalizes
returns – everyone understands what a 25% rate means, compared to the hypothetical
dollar equivalent (the way the NPV is expressed). Unfortunately, there are also several
critical disadvantages with using the IRR to value projects. In the first place, users
should always pick the project with the highest NPV, not necessarily the highest IRR
– because, at the end of the day, his financial statements are measured in dollars, not
percentages. If faced with two projects, Project A with 25% IRR and Project B with
50% IRR, but Project A has a higher NPV, users would pick Project A. The second
big issue is that mathematically, the IRR assumes users can always continue to reinvest
any incremental cash flow at the same IRR, which is infrequently the case. A more
conservative approach is the Modified IRR (MIRR), which assumes reinvestment at
the discount rate.
The IRR Formula
The IRR cannot be derived easily. The only way to calculate it by hand is through trial
and error, because the user is trying to arrive at whatever rate which makes the NPV
equal to zero. For this reason, we'll start with calculating NPV: NPV= ∑ {After-Tax
Cash Flow / (1+r)^t} – Initial Investment
Broken down, each period's after-tax cash flow at time is discounted by some rate, r.
The sum of all these discounted cash flows is then offset by the initial investment,
which equals the current NPV. To find the IRR, user would need to "reverse engineer"
what r is required so that the NPV equaled zero
Financial calculators and software like Microsoft Excel contain specific functions for
calculating IRR, but any calculation is only as good as the data driving it. To determine
the IRR of a given project, the user needs to first reasonably estimate the initial outlay
(the cost of capital investment), and then all the subsequent future cash flows. In almost
every case, arriving at this input data is more complex than the actual calculation
performed.
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Calculating IRR in Excel
There are two ways to calculate IRR in Excel: using one of the three built-in IRR
formulas breaking out the component cash flows and calculating each step
individually, then using those calculations as inputs to an IRR formula. As we detailed
above, since the IRR is a derivation there is no easy way to break it out by hand.
The second method is preferable because financial modeling best practices require
calculations to be transparent and easy to audit. The trouble with piling all of the
calculations into a formula is that the user can't easily see what numbers go where, or
what numbers are user inputs or hard-coded.
Here is a simple example. What makes it simple, among other things, is that the timing
of cash flows is both known and consistent (one year apart). Assume a company is
assessing the profitability of Project X. Project X requires $250,000 in funding and is
expected to generate $100,000 in after-tax cash flows the first year, and then grow by
$50,000 for each of the next four years. User can break out a schedule as follows (if
table is hard to read, right-click and hit "view image"):

(Source: Investopedia Academy)
The initial investment is always negative, because it represents an outflow. User is
spending something now, and anticipating results later. Each subsequent cash flow
could be positive or negative; it depends entirely on the estimates of what the project
delivers in the future.
In this case, we get an IRR of 56.77%. Given our assumption of a weighted average
cost of capital (WACC) of 10%, the project adds value. Keep in mind the limitations
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of IRR: It will not show the actual dollar value of the project, which is why we broke
out the NPV calculation separately. Also, recall that the IRR assumes we can
constantly reinvest and receive a return of 56.77%, which is unlikely. For this reason,
we assumed incremental returns at the risk-free rate of 2%, giving us an MIRR of 33%.
● Payback Period
The payback period is the number of years it takes to recover an initial investment
outlay, as measured in after-tax cash flows. It is an important calculation used in capital
budgeting to help evaluate capital investments. For example, if a payback period is
stated as "2.5 years," it means it will take two-and a-half years, or 30 months, to receive
the entire initial investment back.
How to Calculate Payback Period in Excel
Financial modeling best practices require calculations to be transparent and easily
auditable. The trouble with piling all of the calculations into a formula is that the user
can't easily see what numbers go where, or what numbers are user inputs or hardcoded.
The easiest to audit and understand is to have all the data in one table, then break out
the calculations line by line. Calculating payback period by hand is somewhat
complex. Here is a brief outline of the steps, with the exact formulas in the table below
(note: if it's hard to read, right-click and view it in a new tab to see full resolution):
●
●
●
●

Enter Initial Investment
Enter After-Tax Cash Flows (CF)
Calculate Cumulative Cash Flows (CCC)
Add a Fraction Row, which finds the percentage of remaining negative CCC as a
proportion of the first positive CCC
● Count the number of full years the CCC was negative
● Count the fraction year the CCC was negative
● Add the last two steps to get the exact amount of time in years it will take a break
even
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2.7

STATISTICAL FUNCTIONS

2.7.1 Descriptive Statistics with the use of MS Excel
You can use the Analysis Tool add-in to generate descriptive statistics. For example,
you may have the scores of 14 participants for a test.

To generate descriptive statistics for these scores, execute the following steps.
1. On the Data tab, in the Analysis group, click Data Analysis.

Note: can't find the Data Analysis button? Click here to load the Analysis Tool addin.
2. Select Descriptive Statistics and click OK.

3. Select the range A2: A15 as the Input Range.
4. Select cell C1 as the Output Range.
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5. Make sure summary statistics are checked.

6. Click OK.
Result:

2.7.2 Correlation with the use of MS Excel:
The correlation coefficient (a value between -1 and +1) tells you how strongly two
variables are related to each other. We can use the CORREL function or the Analysis
Tool add-in in Excel to find the correlation coefficient between two variables. A
correlation coefficient of +1 indicates a perfect positive correlation. As variable X
increases, variable Y increases. As variable X decreases, variable Y decreases.
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- A correlation coefficient of -1 indicates a perfect negative correlation. As variable X
increases, variable Z decreases. As variable X decreases, variable Z increases.

- A correlation coefficient near 0 indicates no correlation.
To use the Analysis Tool add-in in Excel to quickly generate correlation coefficients
between multiple variables, execute the following steps.
1. On the Data tab, in the Analysis group, click Data Analysis.

Note: can't find the Data Analysis button? Click here to load the Analysis Tool add-in.
2. Select Correlation and click OK.
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3. For example, select the range A1:C6 as the Input Range.

4. Check Labels in the first row.
5. Select cell A8 as the Output Range.
6. Click OK.

Result:
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Conclusion: variables A and C are positively correlated (0.91). Variables A and B are
not correlated (0.19).
Variables B and C are also not correlated (0.11). You can verify these conclusions by
looking at the graph.
2.7.3 Regression with the use of MS Excel
This example teaches you how to run a linear regression analysis in Excel and how to
interpret the Summary Output. Below you can find our data. The big question is: is
there a relation between Quantity Sold (Output) and Price and Advertising (Input). In
other words: can we predict Quantity sold if we know Price and Advertising?

1. On the Data tab, in the Analysis group, click Data Analysis.

Note: can't find the Data Analysis button? Click here to load the Analysis Tool add-in.
2. Select Regression and click OK.
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3. Select the Y Range (A1:A8). This is the predictor variable (also called dependent
variable).
4. Select the X Range (B1:C8). These are the explanatory variables (also called
independent variables).
These columns must be adjacent to each other.
5. Check Labels.
6. Click in the Output Range box and select cell A11.
7. Check Residuals.
8. Click OK.

Excel produces the following Summary Output (rounded to 3 decimal places).
R Square
R Square equals 0.962, which is a very good fit. 96% of the variation in Quantity Sold
is explained by the independent variables Price and Advertising. The closer to 1, the
better the regression line (read on) fits the data.
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Significance F and P-values
To check if your results are reliable (statistically significant), look at Significance F
(0.001). If this value is less than 0.05, you're OK. If Significance F is greater than 0.05,
it's probably better to stop using this set of independent variables. Delete a variable
with a high P-value (greater than 0.05) and rerun the regression until Significance F
drops below 0.05. Most or all P-values should be below 0.05. In our example this is
the case. (0.000, 0.001 and 0.005).

Coefficients
The regression line is: y = Quantity Sold = 8536.214 -835.722 * Price + 0.592 *
Advertising. In other words, for each unit increase in price, Quantity Sold decreases
with 835.722 units. For each unit increase in Advertising, Quantity Sold increases with
0.592 units. This is valuable information.
You can also use these coefficients to do a forecast. For example, if price equals $4
and Advertising equals $3000, you might be able to achieve a Quantity Sold of
8536.214 -835.722 * 4 + 0.592 * 3000 = 6970.
Residuals
The residuals show you how far away the actual data points are from the predicted data
points (using the equation). For example, the first data point equals 8500. Using the
equation, the predicted data point equals 8536.214 -835.722 * 2 + 0.592 * 2800 =
8523.009, giving a residual of 8500 - 8523.009 = -23.009.
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You can also create a scatter plot of these residuals.

2.7.4 Time Series with the use of MS Excel
This example teaches you how to calculate the moving average of a time series
in Excel. A moving average is used to smooth out irregularities (peaks and valleys) to
easily recognize trends.
1. First, let's take a look at our time series.
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2. On the Data tab, in the Analysis group, click Data Analysis.

Note: can't find the Data Analysis button? Click here to load the Analysis Tool add-in.
3. Select Moving Average and click OK.

4. Click in the Input Range box and select the range B2:M2.
5. Click in the Interval box and type 6.
6. Click in the Output Range box and select cell B3.
7. Click OK.
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8. Plot a graph of these values.

Explanation: Because we set the interval to 6, the moving average is the average of
the previous 5 data points and the current data point. As a result, peaks and valleys are
smoothed out. The graph shows an increasing trend. Excel cannot calculate the moving
average for the first 5 data points because there are not enough previous data points.
9. Repeat steps 2 to 8 for interval = 2 and interval = 4.
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Conclusion: The larger the interval, the more the peaks and valleys are smoothed out.
The smaller the interval, the closer the moving averages are to the actual data points.
2.7

LET’S SUM-UP

Spreadsheet software is very versatile and can be used for both very simple and very
complex tasks. Lists, such as vocabulary, parts for a project or grocery shopping, can
be easily composed in a spreadsheet. Adding or deleting items from a list like this is
also simple, so the lists can be used many times. The management of more complex
data, such as earnings, expenses, budgets and other accounting, is also made easier
with a spreadsheet. Spreadsheet programs include features that can calculate
complicated math, including everything from basic addition and subtraction to
percentages, taxes and multi-step problems. This makes spreadsheets essential for
businesses, self-employed individuals and anyone who needs to keep an account of
expenses and income. Spreadsheet programs also include software that creates graphs
and charts from the data provided within the table. This is good for presentations,
such as business meetings and research projects, and offers a fresh view of the data.
These graphs and charts are customizable and can be specific or general depending on
the settings and options chosen.
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2.8

KEY WORDS

● Payback Period: Payback period in capital budgeting refers to the time required
to recoup the funds expended in an investment, or to reach the break-even point.
● Internal Rate of Return: IRR is the annual rate of growth an investment is
expected to generate.
● Net Present Value: Net present value (NPV) is the difference between the present
value of cash inflows and the present value of cash outflows over a period of time.
● Payroll Accounting : Payroll accounting is essentially the calculation,
management, recording, and analysis of employees' compensation
● Depreciation: Depreciation is an accounting method of allocating the cost of a
tangible or physical asset over its useful life or life expectancy.
● Purchase Order: A purchase order, or PO, is an official document issued by a
buyer committing to pay the seller for the sale of specific products or services to
be delivered in the future.
● Cash Book: A cash book is a financial journal that contains all cash receipts and
disbursements, including bank deposits and withdrawals.
2.9

FURTHER READINGS
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● Fundamentals of Data Management –Saha RG- Himalaya Publishing House
Suggested Readings
● Thareja, IT & Application, Oxford
● Aurora, Computer Fundamentals, Vikash
● Sinha & Sinha, Fundamentals of Computers, BPB Publications
● Dhar, P., Fundamental of IT and Its Application in Business, APH
2.10

MODEL QUESTIONS

Q1:

What is a spreadsheet? Discuss the characteristics and importance of a
spreadsheet.
Differentiate between modelling spreadsheet and operational spreadsheet.
How an electronic spreadsheet is financial accounting?
Write short notes on
a) Petty Cash Book
b) Accounts Payable
c) Purchase Order
d) Asset Accounting
e) Payroll accounting
What are the components of preparing payroll accounting?

Q2:
Q3:
Q4:

Q5:
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